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ABSTRACT
Background Neuromyelitis optica spectrum disorder 
(NMOSD) diagnostic criteria for inflammatory 
demyelinating central nervous system diseases included 
symptomatic narcolepsy; however, no relevant case‐
control studies exist. We aimed to examine the relationship 
among cerebrospinal fluid orexin‐A (CSF‐OX) levels, 
cataplexy and diencephalic syndrome; determine risk 
factors for low- and- intermediate CSF‐OX levels (≤200 pg/
mL) and quantify hypothalamic intensity using MRI.
Methods This ancillary retrospective case‐control study 
included 50 patients with hypersomnia and 68 controls 
(among 3000 patients) from Akita University, the University 
of Tsukuba and community hospitals (200 facilities). 
Outcomes were CSF‐OX level and MRI hypothalamus‐to‐
caudate‐nucleus‐intensity ratio. Risk factors were age, 
sex, hypersomnolence and MRI hypothalamus‐to‐caudate‐
nucleus‐intensity ratio >130%. Logistic regression was 
performed for the association between the risk factors and 
CSF‐OX levels ≤200 pg/mL.
Results The hypersomnia group (n=50) had significantly 
more cases of NMOSD (p<0.001), diencephalic syndrome 
(p=0.006), corticosteroid use (p=0.011), hypothalamic 
lesions (p<0.023) and early treatment (p<0.001). No 
cataplexy occurred. In the hypersomnia group, the median 
CSF- OX level was 160.5 (IQR 108.4–236.5) pg/mL and 
median MRI hypothalamus- to- caudate- nucleus- intensity 
ratio was 127.6% (IQR 115.3–149.1). Significant risk 
factors were hypersomnolence (adjusted OR (AOR) 6.95; 
95% CI 2.64 to 18.29; p<0.001) and MRI hypothalamus‐
to‐caudate‐nucleus‐intensity ratio >130% (AOR 6.33; 95% 
CI 1.18 to 34.09; p=0.032). The latter was less sensitive 
in predicting CSF- OX levels ≤200 pg/mL. Cases with MRI 
hypothalamus- to- caudate- nucleus- intensity ratio >130% 
had a higher rate of diencephalic syndrome (p<0.001, 
V=0.59).
Conclusions Considering orexin as reflected by CSF‐OX 
levels and MRI hypothalamus‐to‐caudate‐nucleus‐intensity 
ratio may help diagnose hypersomnia with diencephalic 
syndrome.

INTRODUCTION
In 2009, hypersomnia with various events 
of diencephalic syndrome was reported in 

the autopsy report of a girl aged 17 years 
with neuromyelitis optica spectrum disorder 
(NMOSD)1; necrosis had been noted in her 
hypothalamus 21 months after disease onset. 
Thereafter, diencephalic syndrome and 
symptomatic narcolepsy were incorporated 
for the first time in the 2015 NMOSD diag-
nostic criteria2 for inflammatory demyelin-
ating diseases of the central nervous system 
(IDDCNS).3 The category of diencephalic 
syndrome4 includes multihypothalamic 
dysfunction (ie, syndrome of inappropriate 
secretion of antidiuretic hormone, hypoten-
sion, abnormal body temperature, eating 
disorder, panhypopituitarism, amenorrhoea 
and memory impairment). Narcolepsy is a 
condition in which patients exhibit hyper-
somnia, characterised by excessive daytime 
sleepiness5 (EDS) (ie, unbearable daytime 

WHAT IS ALREADY KNOWN ON THIS TOPIC
 ⇒ No relevant case- control studies exist for symptom-
atic narcolepsy in inflammatory demyelinating dis-
eases of the central nervous system (IDDCNS).

WHAT THIS STUDY ADDS
 ⇒ In this study, the hypersomnia group exhibited hy-
persomnolence at intermediate cerebrospinal fluid 
orexin‐A (CSF- OX) levels without cataplexy.

 ⇒ Characteristic hypersomnolence was a risk factor for 
cases with CSF- OX levels ≤200 pg/mL, and quanti-
tative hypothalamic lesions (MRI) hypothalamus- 
to- caudate- nucleus- intensity ratio >130%) were 
frequent features of diencephalic syndrome.

HOW THIS STUDY MIGHT AFFECT RESEARCH, 
PRACTICE OR POLICY

 ⇒ Intermediate CSF- OX levels and an MRI 
hypothalamus- to- caudate- nucleus- intensity ratio 
>130% are hypersomnia characteristics caused by 
IDDCNS, and the combination of both can be applied 
to detect hypersomnia with diencephalic syndrome.
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sleepiness or falling asleep). The pathological hallmark of 
narcolepsy is impaired orexin function within the central 
nervous system, which has been associated with neuro-
logical disorders; therefore, cerebrospinal fluid orexin- A 
(hypocretin- 1) concentrations (CSF- OX levels)6 are deter-
mined to aid in diagnosis. CSF- OX levels are classified as 
≤110 pg/mL (low), >110 to ≤200 pg/mL (intermediate) 
and >200 pg/mL (normal).6 The diagnosis of narcolepsy 
in the International Classification of Sleep Disorders 
Third Edition5 (ICSD- 3) is based on low CSF- OX levels.7 
Diagnosis in the absence of CSF- OX levels requires rapid 
eye movement (REM) sleep abnormalities and the devel-
opment of cataplexy and electrophysiological assessment 
using the multiple sleep latency test (MSLT).

Generally, hypersomnia caused by IDDCNS8–10 (eg, 
NMOSD) does not meet the ICSD- 3 narcolepsy criteria, 
as it is classified as hypersomnia due to a medical 
disorder, which differs from EDS in idiopathic narcolepsy. 
It is characterised by excessive nocturnal sleep, EDS or 
excessive napping. Some key details remain unclear. First, 
cataplexy is often absent, except when associated with 
human leucocyte antigen (DQB1*06:02), which is typical 
of idiopathic narcolepsy.11 MSLT and polysomnography 
(PSG) are less frequently performed,12 and diencephalic 
syndrome tends to be more common8–10 12–14; however, 
these findings are based on case reports. Second, hyper-
somnia due to medical disorders were reported in patients 
with hypersomnolence15 and even those with interme-
diate CSF- OX levels, while decreased CSF- OX levels were 
not reported in patients with multiple sclerosis (MS).16 
Thus, hypersomnia due to medical disorders cannot be 
characterised based on features specific to a single disease 
entity. Third, hypersomnia in IDDCNS has been associ-
ated with a high rate of hypothalamic lesions diagnosed 
using MRI. These findings have been qualitatively eval-
uated17 to be different from those associated with idio-
pathic narcolepsy18; however, the relation between lesion 
severity and CSF- OX levels is unclear. Therefore, we 
conducted a case- control study to retrospectively examine 
the CSF- OX levels in patients with hypersomnia due to 
IDDCNS. We also aimed to assess the frequency of cata-
plexy and diencephalic syndrome and risk factors asso-
ciated with low- and- intermediate CSF- OX levels, which 
are frequently reported in cases of hypersomnia due to 
medical disorders. Furthermore, we developed a method 
for quantifying hypothalamic intensity using MRI to iden-
tify factors associated with abnormal values.

METHODS
Study design and setting
This ancillary retrospective case- control study used 
existing CSF- OX data collected between 1 April 2000 
and 31 December 2020. CSF- OX measurements were 
performed at Akita University until March 2019 and at 
the University of Tsukuba after April 2019. The number 
of patients, excluding duplicates, who underwent 
CSF- OX measurements was 3000; inpatients’ samples 

were collected from 200 facilities (community hospitals) 
in Asia.

Participants
We identified patients with hypersomnia and controls 
among patients with IDDCNS from the Akita University/
University of Tsukuba databases based on the CSF- OX 
levels. Hypersomnolence was defined as excessive 
nocturnal sleep, EDS or excessive napping.5 Prolonged 
sleep time was defined as a total sleep time of ≥660 min 
during 24 hours, following the diagnostic criteria for 
idiopathic hypersomnia,5 based on the patient’s or family 
member’s report. As hypersomnolence and CSF- OX 
levels associated with IDDCNS tend to improve rapidly 
with early treatment,19 the hypersomnolence duration 
should be at least 24 hours when suspecting acute exacer-
bations20 as opposed to the duration of at least 3 months 
as specified by the ICSD- 3.5 The control group included 
cases without hypersomnolence with acute exacerba-
tion of core clinical characteristics2 (ie, optic neuritis, 
acute myelitis, area postrema syndrome, acute brainstem 
syndrome, diencephalic syndrome and symptomatic 
cerebral syndrome). IDDCNS3 included MS,20 NMOSD,3 
myelin oligodendrocyte glycoprotein- antibody- associated 
disease (MOGAD)21 and acute disseminated encephalo-
myelitis (ADEM).22

CSF samples were collected within 6 months8 of hyper-
somnolence onset before or during treatment. MRI data 
during the last 30 days20 before or after the CSF sample 
collection date and before or during treatment were anal-
ysed. The initial imaging method23 included T2- weighted 
two- dimensional fluid- attenuated inversion recovery 
(T2- weighted- 2D FLAIR) or T2- weighted sequences, while 
the other method was diffusion- weighted imaging.24 Two 
types of imaging planes were available: an axial23 and a 
coronal.25 The slice thickness was <5 mm,26 magnetic field 
strength was ≥1.5 T, echo time was approximately 120 ms 
and repetition time was >10 000 ms.

The inclusion criteria for this study were confirmation 
or suspicion of IDDCNS (unclassifiable IDDCNS2 desig-
nated when autoantibody (eg, against aquaporin- 4 or 
myelin oligodendrocyte glycoprotein) status was nega-
tive or untested, but the differential diagnosis could be 
excluded, and the diagnosis by the attending physician 
was IDDCNS (online supplemental table 1: cases 2, 6)), 
complete CSF and MRI data as described above and avail-
able follow- up information. The exclusion criteria were 
sleep disorders other than hypersomnia due to IDDCNS, 
primary hypersomnia, hypersomnia due to medications 
or substances, hypersomnia due to medical disorders 
other than IDDCNS, hypersomnia associated with psychi-
atric disorders, failure to meet the inclusion criteria and 
lack of follow- up information.

Data sources/data collection/measurements
The database consisted of the CSF- OX levels obtained 
according to the measurement protocol27 and responses 
to open- ended questions from attending physicians. 
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Questions regarding dates (ie, CSF sample collection, 
hypersomnolence and date of birth), sex, race, height, 
weight, diagnosis, core clinical characteristics, cataplexy, 
sleep paralysis, the Japanese version of the Epworth 
Sleepiness Scale, Expanded Disability Status Scale, 
treatments (eg, corticosteroids), time from treatment 
initiation, hypersomnolence duration, biochemical exam-
ination (eg, human leucocyte antigen (DQB1*06:02, 
DRB1*15:01)), MSLT (sleep latency, sleep- onset REM 
periods and REM latency) and PSG (total sleep time and 
sleep efficiency) were included. Data regarding patient 
name, diagnosis, hypersomnolence and CSF- OX levels in 
the spreadsheet were deleted and randomly assigned an 
identification number.

The follow- up cataplexy (observed until 31 December 
2020) and MRI data were collected from 4 January to 31 
July 2021. MRI data were anonymised by staff and given a 
specific identification number.

Two physicians performed the MRI analysis. The brain 
was divided into 23 regions for qualitative evaluation 
of lesions. The image analysis software Fiji28 was used 
to quantify intensity levels29 and is a plug- in of ImageJ 
(National Institutes of Health, Bethesda, Maryland, 
USA)30 commonly used for microscopic image analysis. 
The intensity was recorded as the luminance value per 
pixel (µm2). The data were processed via 8- bit grayscale 
conversion without segmentation and filtering. The 
procedure for measuring the intensity levels is described 
with reference to the Fiji screen in figure 1A. Identifica-
tion and measurement of intensities of the hypothalamus 
and caudate nucleus were performed visually and manu-
ally,29 with the image enlarged to facilitate identification. 
The region of interest was required to be set at an appro-
priate distance from the CSF site to avoid interference of 
choroid plexus and CSF artefacts. We defined the MRI 
hypothalamus- to- caudate- nucleus- intensity (MRI H/C) 
ratio (%) as the intensity levels of the bilateral hypothal-
amus relative to the bilateral caudate nucleus (figure 1B). 
The MRI H/C ratio (%) was calculated as follows: (mean 
intensity data of the hypothalamus)/(the mean inten-
sity data of the caudate nucleus)×100. The results were 
recorded as the average of three measurements taken 
by two physicians. We modified a previously reported 
method29 that quantified intensity using ImageJ to stan-
dardise the caudate nucleus rather than the CSF.31–33 All 
measurements were performed on macOS 11 and 12 
(Apple, Cupertino, California, USA).

Candidate risk factors
The primary risk factors were age and sex. There were 
significant differences in age at onset and sex between 
patients with NMOSD and MOGAD.34 The overall mean 
age at onset was 40 years; therefore, we used two cate-
gories: >40 years and ≤40 years. Subsequently, a major 
difference was observed in the occurrence of hypersom-
nolence.5 Finally, an MRI H/C ratio >130% indicated a 
reversible active hypothalamic lesion.1 23 35

Outcomes
The main outcome was the CSF- OX level,6 reflecting 
dysfunction of the orexin nervous system. The secondary 
outcome was the MRI H/C ratio.

Statistical analysis
Patient characteristics were described using the median 
and IQR for interval variables and numbers and percent-
ages (%) for categorical variables. Differences in interval 
variables between the hypersomnia and control groups 
were analysed using the Mann- Whitney U test, and cate-
gorical variables were tested using Pearson’s χ2 or Fisher’s 
exact test based on the expected frequency assumption. 
Bonferroni correction was performed by multiplying 
p values by 6, 11 and 23 for core clinical characteris-
tics, treatments and brain MRI lesions, respectively. The 
correlation between the MRI H/C ratio and CSF- OX 
levels was analysed using Spearman’s rank correlation 
coefficients. The limit for detecting CSF- OX levels was 
defined as 40 pg/mL.7

Binary logistic regression analysis was used to examine 
the association between the four risk factors (ie, age at 
onset >40 years, male sex, the occurrence of hypersom-
nolence and an MRI H/C ratio >130%) and outcome (ie, 
low- and- intermediate CSF- OX levels). The variables in 
the model were entered using the forced entry method 
with no missing values. The sample size was estimated 
using Pearson’s χ2 test and based on a previous study.6 
Finally, with an expected dropout rate of 20%, 25 and 38 
individuals were included in the hypersomnia and control 
groups, respectively (online supplemental figure 1).

Three subgroup analyses were performed. The first 
assessed the heterogeneity of CSF- OX levels at diagnosis. 
The second assessed heterogeneity of the frequency of 
diencephalic syndrome by combining qualitative data on 
hypothalamic lesions and quantitative MRI H/C >130% 
and ≤130% values. The third assessed heterogeneity of 
the frequency of diencephalic syndrome in the hyper-
somnia groups with low- and- intermediate and normal 
CSF- OX levels.

The statistical significance threshold was set at a two- 
sided p<0.05. All statistical analyses were performed using 
IBM SPSS Statistics V.28.0.0.0 (IBM, Armonk, New York, 
USA). Biostatisticians independently verified all analyses 
in this study.

RESULTS
Between 1 April 2000 and 31 December 2020, 3000 
cases, excluding duplicates, were recorded. Of these, 
114 cases of sleep disorders other than hypersomnia due 
to IDDCNS, 2137 of primary hypersomnia, 28 of use of 
hypersomnia medications or substances, 481 of hyper-
somnia due to medical disorders except IDDCNS, 100 
of hypersomnia associated with psychiatric disorders, 2 
where the differential diagnosis could not be excluded, 
1 with the post- treatment CSF sample, 14 without MRI 
data and 5 with no information on cataplexy owing to 
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deaths were excluded. The remaining 118 patients were 
included in the current analysis (online supplemental 
figure 1). The median (IQR) age at onset was 39.4 (28.6–
53.6) years; 12 (10.2%) patients were aged ≤18 years, 85 

(72.0%) were females and 115 (97.5%) were Japanese. 
The hypersomnia group (n=50) had significantly more 
age ≤18 years (p=0.028), patients with NMOSD and 
ADEM (p<0.001) and diencephalic syndrome (p=0.006), 

Figure 1 Definition of the MRI hypothalamus- to- caudate- nucleus- intensity ratio. (A) Procedure for measuring the intensity 
levels. The Fiji screen is shown. The numbers indicate the steps. (1) Opening image files (File>Import>Image Sequence). (2) 
Processing the image before analysis: convert to 8- bit grayscale (Image>Type>8- bit). (3) Setting measurement items: select the 
mean gray value (Analyse>Set Measurements>Mean gray value (Mean)). (4) Designating and measuring the region of interest 
(ROI): select the segmented line (Area Selection Tools>Straight Line Selection Tool>Segmented Line) and view ROI manager 
(Analyse>Tools>ROI Manager). (5) Identifying and measuring the hypothalamus and caudate nucleus visually and manually, 
with the image enlarged to facilitate identification (Add>Measure). (6) Checking and saving the results. Permission was obtained 
for the images. (B) We defined the MRI hypothalamus- to- caudate- nucleus- intensity (MRI H/C) ratio (%) as the intensity level of 
the bilateral hypothalamus relative to that of the bilateral caudate nucleus. Quantification of the intensity levels was performed 
using the image analysis software Fiji. Data were processed via 8- bit grayscale conversion without segmentation and filtering. 
Identification and measurement of the hypothalamus and caudate nucleus were performed visually and manually by enlarging 
the images. The ROI was required to be set at an appropriate distance from the cerebrospinal fluid site to avoid interference of 
choroid plexus and cerebrospinal fluid artefacts. Anatomography was used to illustrate the location of the hypothalamus and 
caudate nucleus.
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frequent corticosteroid therapy (p=0.011) and thalamic 
and hypothalamic lesions (both p<0.023) and an earlier 
treatment initiation (p<0.001) than the control group. 
No cataplexy occurred (table 1, online supplemental 
tables 1 and 2). The relationships between variables are 
described in online supplemental figures 2–4 and online 
supplemental table 3.

CSF-OX levels and MRI H/C ratios in the hypersomnia group
We obtained CSF- OX levels and MRI H/C ratios for the 
hypersomnia group. The median (IQR) CSF- OX level 
was 160.5 (108.4–236.5) pg/mL (ie, intermediate) in 
the hypersomnia group and 282.3 (216.3–371.7) pg/
mL (ie, normal) in the control group (p<0.001). The 
median difference between the two groups was 43% 
(figure 2, online supplemental table 4). Low CSF- OX 
level was found only in the hypersomnia group (online 

supplemental table 4). The median (IQR) MRI H/C ratio 
was 127.6% (115.3–149.1) in the hypersomnia group 
and 96.1% (88.3–105.0) in the control group (p<0.001) 
(online supplemental table 5). We observed a negative 
correlation between the MRI H/C ratio and CSF- OX 
level (ρ=−0.42, p<0.001) (figure 3). Characteristic images 
classified by an MRI H/C ratio >130% and ≤130% and 
CSF- OX level (ie, low, intermediate and normal) are 
shown in figure 3. The MRI H/C ratio of all 50 patients in 
the hypersomnia group is shown in online supplemental 
table 1. The brain MRI retention rates of lesions classi-
fied into 23 regions in 118 patients are shown in online 
supplemental table 5.

Table 1 Characteristics of the 118 patients with inflammatory demyelinating diseases of the central nervous system

Variables Hypersomnia (n=50) Control (n=68) P value*

Age at onset, years 38.5 (21.0–50.3) 41.5 (30.3–54.5) 0.159

Age ≤18 years, no. (%) 9 (18.0) 3 (4.4) 0.028

Sex, no. (%)

  Female 40 (80.0) 45 (66.2) 0.098

  Male 10 (20.0) 23 (33.8)

Japanese, no. (%) 48 (96.0) 67 (98.5) 0.386

Diagnosis, no. (%)

  NMOSD 33 (66.0) 10 (14.7) <0.001

  MOGAD 5 (10.0) 3 (4.4)

  MS 6 (12.0) 55 (80.9)

  ADEM 4 (8.0) 0

  Unclassifiable IDDCNS† 2 (4.0) 0

Core clinical characteristics, no. (%)

  Diencephalic syndrome 20 (40.0) 0 0.006

Hypersomnolence, no. (%) 50 (100.0) 0 NA

Cataplexy, no. (%) 0 0 NA

Treatments, no. (%)

  Corticosteroid therapy 49 (98.0) 41 (60.3) 0.011

Time from treatment initiation, years 0.1 (0–0.2) 2.2 (0.3–7.4) <0.001

Brain MRI lesions, no. (%)

  Caudate nucleus 2 (4.0) 0 >0.99

  Thalamus 27 (54.0) 1 (1.5) 0.023

  Hypothalamus 45 (90.0) 0 0.023

Data are presented using the median and IQR for interval variables and numbers and percentages (%) for categorical variables.
*P values were calculated using Pearson’s χ2 test or Fisher’s exact test for categorical variables and the Mann- Whitney U test for interval 
variables. The threshold for statistical significance was two- sided p<0.05. Bonferroni correction was used for core clinical characteristics by 
multiplying p values with 6, for corticosteroid therapy by multiplying p values with 11 and for brain MRI lesions by multiplying p values with 
23.
†Unclassifiable IDDCNS: autoantibody (eg, against aquaporin- 4 or myelin oligodendrocyte glycoprotein) status was negative or untested, but 
the differential diagnosis could be excluded.
ADEM, acute disseminated encephalomyelitis; IDDCNS, inflammatory demyelinating diseases of the central nervous system; MOGAD, myelin 
oligodendrocyte glycoprotein- antibody- associated disease; MS, multiple sclerosis; NA, not assessed; NMOSD, neuromyelitis optica spectrum 
disorder .
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Risk factors associated with low-and-intermediate CSF-OX 
levels
We explored risk factors associated with low- and- 
intermediate CSF- OX levels. The coefficients of associ-
ation between the four risk factors are listed in online 
supplemental figure 5. Occurrence of hypersomnolence 
(adjusted OR=6.95; 95% CI (CI)=2.64–18.29; p<0.001) 
and an MRI H/C ratio>130% (adjusted OR 6.33; 95% 
CI 1.18 to 34.09; p=0.032) were significantly associated 
risk factors with low- and- intermediate CSF- OX levels 
(table 2), while an MRI H/C ratio >130% was less sensi-
tive in predicting CSF- OX levels ≤200 pg/mL (online 
supplemental figure 6). The results of the Hosmer- 
Lemeshow test as a goodness- of- fit test were not signifi-
cant (χ2 value 11.37; p=0.078). There were no covariate 
patterns with standardised Pearson’s residuals >2.0 and 
no outliers. Additionally, no multicollinearity of covari-
ates was observed with a tolerance >0.2 and a variance 
inflation factor <5 (online supplemental table 6).

Results of subgroup analyses
We evaluated the differences in CSF- OX levels and MRI 
H/C ratios between the subgroups. CSF- OX levels did 
not differ according to the diagnosis in the hypersomnia 
group after Bonferroni correction (figure 4). Of the 45 
patients with qualitative hypothalamic lesions, 20 had 
quantitative hypothalamic lesions (ie, MRI H/C ratios 
>130%) (online supplemental table 7). Patients with 

MRI H/C ratios >130% with qualitative hypothalamic 
lesions had a significantly higher rate of diencephalic 
syndrome complications (p<0.001, V=0.59) than those 
without (online supplemental table 7). The hypersomnia 
group with low- and- intermediate CSF- OX levels had a 
significantly higher frequency of diencephalic syndrome 
(p=0.003, Φ=0.42) than the hypersomnia group with 
normal CSF- OX levels (online supplemental table 8).

DISCUSSION
The hypersomnia group had a higher frequency of dien-
cephalic syndrome and hypothalamic lesions and an 
earlier start of treatment than the control group. The 
hypersomnia group had intermediate CSF- OX levels and 
higher MRI H/C ratios than the control group. The risk 
factors associated with low- and- intermediate CSF- OX 
levels were the occurrence of hypersomnolence and an 
MRI H/C ratio >130%, while an MRI H/C ratio >130% 
was less sensitive in predicting CSF- OX levels ≤200 pg/
mL.

We observed a difference in the time from treatment 
initiation. For patients with idiopathic narcolepsy, this 
period was 14.63 (14.31) years,36 whereas it was 0.1 
(0–0.2) years for those with hypersomnia. Cataplexy is the 
hallmark symptom of narcolepsy, and it is triggered by 
an abrupt transition from arousal to REM sleep. Chronic 
orexin deficiency is assumed to involve cataplexy expres-
sion.37 Autopsy reports of patients with idiopathic narco-
lepsy with cataplexy showed orexin- expressing neuron 
loss rates >85%–90%.37 After a 10- year follow- up of 127 
patients with idiopathic narcolepsy without cataplexy, 
10% of patients in the low CFS- OX group exhibited 
cataplexy,38 whereas after 9.5 (5.5–12.6) years of post- 
treatment follow- ups, none of the 12 patients in the low 
CSF- OX group exhibited cataplexy (online supplemental 
table 1). In patients with hypersomnia due to IDDCNS, 
damage to the orexin nervous system progresses rapidly,1 
and the time to treatment initiation is short. Further-
more, 98% of patients in our study were treated with 
corticosteroids, likely in the absence of a chronic orexin- 
deficient state. Therefore, recovery of CSF- OX levels 
was observed during post- treatment monitoring (online 
supplemental table 1: cases 1, 2, 10, 12). The consider-
ation of orexin levels and MRI quantification, pathology 
and qualitative MRI allowed us to identify an association 
with diencephalic syndrome. CSF- OX levels reflect the 
degree of injury to orexin neurons localised in the lateral 
hypothalamus.33 Conversely, the diencephalic syndrome 
associated with IDDCNS present with diverse symptoms 
due to extensive and intense hypothalamic injury. MRI is 
suitable for capturing a wide range of injuries. Further-
more, other studies have suggested that neuroimaging 
using T2- weighted- 2D FLAIR reflects the pathogenesis 
of acute IDDCNS.1 23 In a patient who presented with 
hypersomnolence and diencephalic syndrome and was 
diagnosed postmortem with NMOSD, hypothalamic 
lesions 21 months from onset showed necrosis that could 

Figure 2 Violin plots of cerebrospinal fluid orexin- A (CSF- 
OX) levels of 118 patients with inflammatory demyelinating 
diseases of the central nervous system. The y- axis indicates 
the CSF- OX (hypocretin- 1) levels. The dots indicate patients’ 
CSF- OX data. The thick lines indicate the medians, and the 
thin lines indicate the IQRs. The limit of detection for CSF- 
OX levels is 40 pg/mL. The median (IQR) CSF- OX level was 
160.5 (108.4–236.5) pg/mL for the hypersomnia group and 
282.3 (216.3–371.7) pg/mL for the control group. The Mann- 
Whitney U test revealed a significant difference between the 
two groups (p<0.001).
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not be immunostained by pathology, but MRI imaging 
abnormalities were not prominent.1 On retracing the 
history, pathological gliosis at 8 months from onset was 
reflected as an abnormal MRI signal. Here, patients 
with MRI H/C ratios >130% also indicated significantly 
higher complication rates for diencephalic syndrome 
(p<0.001, V=0.59) (online supplemental table 7). More-
over, the hypersomnia group with low- and- intermediate 
CSF- OX levels had a significantly higher frequency of 
diencephalic syndrome (p=0.003, Φ=0.42) than did the 

hypersomnia group with normal CSF- OX levels (online 
supplemental table 8). Furthermore, we demonstrated 
that MRI intensity is indistinguishable between necrotic 
and normal tissues with an equal signal (figure 3). There-
fore, the combination of MRI H/C ratios and CSF- OX 
levels can indicate patients with hypersomnia due to 
IDDCNS with diencephalic syndrome requiring rigorous 
treatment. Furthermore, our results support those of a 
recent study,15 indicating that intermediate CSF- OX levels 

Figure 3 Correlation between the MRI hypothalamus- to- caudate- nucleus- intensity ratios and cerebrospinal fluid orexin- A 
(CSF- OX) levels. (A) Correlogram with dots representing individual cases projected by the MRI hypothalamus- to- caudate- 
nucleus- intensity (MRI H/C) ratios (x- axis) and the CSF- OX (hypocretin- 1) levels (y- axis). Filled dots indicate the hypersomnia 
group; unfilled dots indicate the control group. The MRI H/C ratio is a quantified index of hypothalamic intensity data based 
on the caudate nucleus (figure 1). A significant negative correlation was observed between the MRI H/C ratio and CSF- OX 
levels (ρ=−0.42, p<0.001). Asterisks indicate cases with representative brain MRI data (a, control; b–f, hypersomnia). (B) 
Representative T2- weighted fluid- attenuated inversion recovery MRI of the brain in patients from two MRI H/C ratio categories 
and three CSF- OX level categories: MRI H/C ratio >130%, MRI H/C ratio ≤130%, low CSF- OX level (≤110 pg/mL), intermediate 
CSF- OX level (>110 to <200 pg/mL) and normal CSF- OX level (>200 pg/mL). a, Multiple sclerosis (MS), CSF- OX level 238.1 pg/
mL, and MRI H/C ratio 115.0%. b, Neuromyelitis optica spectrum disorder (NMOSD), CSF- OX level 345.0 pg/mL, and MRI H/C 
ratio 147.8%. c, Acute disseminated encephalomyelitis, CSF- OX level 177.0 pg/mL and MRI H/C ratio 121.4%. d, MS, CSF- 
OX level 152.0 pg/mL and MRI H/C ratio 166.2%. e, NMOSD, CSF- OX level 20.9 pg/mL and MRI H/C ratio 122.6%. f, Myelin 
oligodendrocyte glycoprotein- antibody- associated disease, CSF- OX level 75.0 pg/mL and MRI H/C ratio 206.5%. Permission 
was obtained for all the images.
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may also be abnormal in patients with symptomatic hyper-
somnia. We found that the median CSF- OX level in the 
hypersomnia group was intermediate at 160.5 pg/mL 
(figure 2). Patients with hypersomnolence had a higher 
likelihood of low- and- intermediate CSF- OX levels than 
the controls. CSF- OX levels are normal in those with idio-
pathic hypersomnia,5 the pathophysiology of which may 
differ from that of idiopathic narcolepsy. The pathogen-
esis of hypersomnia due to IDDCNS may be similar to 
that of idiopathic hypersomnia, even though the CSF- OX 
levels may differ and are often intermediate. Finally, we 
found no difference in the heterogeneity of CSF- OX 
levels at diagnosis in patients with hypersomnia due to 
IDDCNS (figure 4).

A negative finding of this study is that an MRI H/C ratio 
>130%, one of the risk factors associated with low- and- 
intermediate CSF- OX levels, is less sensitive to predict 
CSF- OX levels ≤200 pg/mL (online supplemental figure 
6). Some patients develop hypersomnia despite normal 
CSF- OX levels; additionally, there is no hypersomnolence 
despite intermediate CSF- OX levels. Lastly, MRI intensity 
is indistinguishable between necrotic and normal tissues 
with an equal signal. Therefore, we tested the validity of 
the MRI H/C ratio (table 3). The MRI H/C ratio showed 
variability in results in the absence of hypothalamic 
lesions but adequately reflected the intensity in the pres-
ence of lesions. We made two major innovations. In the 
former, we set a cut- off value for the MRI H/C ratio in 
advance. The MRI H/C ratio >130% is based on the % 
difference ≤30% of medical displays with uniform lumi-
nance.35 Normal tissue and lesion areas were assumed to 

have a % difference of >30% due to non- uniformity of 
luminance. The latter is a protocol modification from a 
previous study29 that quantified intensities using ImageJ 
to standardise the caudate nucleus rather than the CSF. 
The CSF pulsation is also an artefact31; thus, the anatom-
ical conditions were aligned around the ventricles. Addi-
tionally, caudate nucleus lesions are not specific for 
IDDCNS in adults.32 Furthermore, the caudate nucleus 
is not a direct input/output site for orexin neurons in 
rats.33

In our study, 78% of the hypersomnia group only had 
hypersomnolence, and 96% visited physicians or medical 
institutions that did not specialise in sleep medicine 
(online supplemental table 2). The large and diverse 
sample of this study makes the results easily applicable 
in clinical practice. Existing data were used, and no new 
medical resources were required. T2- weighted- 2D FLAIR 
is used in routine examinations to diagnose IDDCNS.23 
Moreover, Fiji is a free, highly reliable and publicly avail-
able software developed by the National Institutes of 
Health.28

Limitations
First, two cases of unclassifiable diagnoses were included 
in the analysis, which may have caused selection bias. 
However, there was no significant difference in the results 
after excluding their data. Second, iron deposition in the 
caudate nucleus can occur in MS,39 which may affect the 
MRI H/C ratio. However, there were no differences in 
the MRI H/C ratios in the control group based on the 
presence of caudate nucleus lesions.

Table 2 Factors associated with CSF- OX levels ≤200 pg/mL in the 118 patients with inflammatory demyelinating diseases of 
the central nervous system

Variables

CSF- OX levels, pg/mL

Crude OR (95% CI) P value Adjusted OR (95% CI) P value

≤200 (n=48) >200 (n=70)

No. (%) No. (%)

Age at onset, years

  ≤40 27 (56.3) 34 (48.6) 1 (reference) NA 1 (reference) NA

  >40 21 (43.7) 36 (51.4) 0.74 (0.35 to 1.54) 0.413 0.63 (0.25 to 1.61) 0.338

Sex

  Female 37 (77.1) 48 (68.6) 1 (reference) NA 1 (reference) NA

  Male 11 (22.9) 22 (31.4) 0.65 (0.28 to 1.50) 0.313 1.06 (0.25 to 1.61) 0.913

Hypersomnolence

  Without 12 (25.0) 56 (80.0) 1 (reference) NA 1 (reference) NA

  With 36 (75.0) 14 (20.0) 12.00 (4.99 to 28.86) <0.001 6.95 (2.64 to 18.29) <0.001

MRI H/C ratio, %

  ≤130 31 (64.6) 67 (95.7) 1 (reference) NA 1 (reference) NA

  >130 17 (35.4) 3 (4.3) 12.25 (3.34 to 44.90) <0.001 6.33 (1.18 to 34.09) 0.032

Binary logistic regression analysis was used to examine the association of CSF- OX (hypocretin- 1) levels ≤200 pg/mL (low and intermediate 
groups) with four risk factors as covariates: age at onset >40 years, male sex, hypersomnolence and MRI H/C ratio >130%. The Hosmer- 
Lemeshow test results were non- significant. There were no covariate patterns with standardised Pearson’s residuals >2.0, no outliers and no 
multicollinearity among the covariates.
CSF- OX, cerebrospinal fluid orexin- A; MRI H/C ratio, MRI hypothalamus- to- caudate- nucleus- intensity ratio; NA, not assessed.

https://dx.doi.org/10.1136/bmjno-2023-000428
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CONCLUSION
We found that patients with hypersomnia due to IDDCNS 
included more NMOSD cases and cases with intermediate 
CSF- OX levels than the controls. Notably, no cases of cata-
plexy were observed in patients with hypersomnia due to 
IDDCNS, in contrast to typical findings in cases of idio-
pathic narcolepsy. The results suggest that the combina-
tion of MRI H/C ratios and CSF- OX levels can be applied 
to detect hypersomnia with diencephalic syndrome. 

Figure 4 Violin plots of cerebrospinal fluid orexin- A (CSF- 
OX) levels by diagnosis for 50 patients with hypersomnia and 
68 control patients with inflammatory demyelinating diseases 
of the central nervous system. Panels A and B show the 
results for the hypersomnia and control groups, respectively. 
The x- axis indicates diagnosis of inflammatory demyelinating 
diseases of the central nervous system, and the y- axis 
indicates CSF- OX (hypocretin- 1) levels. Dots indicate 
patients’ CSF- OX data. The thick lines indicate the medians 
and the thin lines indicate the IQRs. The limit for detecting 
CSF- OX levels was defined as 40 pg/mL. Unclassifiable 
inflammatory demyelinating diseases of the central nervous 
system: autoantibody (eg, against aquaporin- 4 or myelin 
oligodendrocyte glycoprotein) status was negative or 
untested, but the differential diagnosis could be excluded. 
The median (IQR) CSF- OX levels in the hypersomnia group 
were 157.0 (115.6–191.5) pg/mL for NMOSD, 81.0 (77.5–
194.5) pg/mL for MOGAD, 265.0 (124.0–311.1) pg/mL for 
MS, 191.0 (174.8–295.8) pg/mL for ADEM and 57.5 (40.0–
NA) pg/mL for unclassifiable IDDCNS. Differences in the 
CSF- OX levels between the five hypersomnia groups were 
compared using the Kruskal- Wallis H test and were found to 
be significant (p=0.033), but Bonferroni correction showed 
no difference by diagnosis. ADEM, acute disseminated 
encephalomyelitis; MOGAD, myelin oligodendrocyte 
glycoprotein- antibody- associated disease; MS, multiple 
sclerosis; NMOSD, neuromyelitis optica spectrum disorders.
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Further validation of the MRI H/C ratio in additional 
IDDCNS cases is needed in the future.
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